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 بستِ هحتَیات.1

 پشٍگشاهش •
  کبهپَ٘تش ثِ پشٍگشاهش اتصبل USB کبثل• 

 ه٘کشٍکٌتشلش ثِ پشٍگشاهش اتصبل کبثل •
 ؿبهل افضاس ًشم فـشدُ لَح •

AVR Studio 4– 

CodeVisionAVR – 

FLIP – 

 

 MKII.مشخصات پروگرامر 2

 هجضا تغزِٗ هٌجغ ثِ ً٘بص ثذٍى - 

  ISP ،PDI ّبٕ ٍاػظ داسإ - 

 .کشدى پشٍگشام ػشػت افضاسٕ ًشم تٌظ٘ن - 

  xmegaٕػش ٕکشٍّب٘پشٍگشام ه ٕثشا  PDI پشٍتکل - 

  USB اػتبًذاسد ّبٕ پَست عشٗق اص کبهپَ٘تش ثِ اتصبل - 

 .جذٗذ ه٘کشٍّبٕ اص پـت٘جبًٖ هٌظَس ثِ پشٍگشاهش سػبًٖ سٍص ثِ قبثل٘ت - 

 ATMEL AVR Studio, CodeVisionAVR, ATMEL Studio قج٘ل اص افضاسّبٖٗ ًشم تَػظ پشٍگشاهش ؿٌبػبٖٗ - 

ٍ XP (32Bit , 64Bit )ٍ  7ٍ  8 11ٍ ٌذٍصٍٗ ل٘اص قج جٗسا ٕػبهل ّب ؼتن٘ػ ٍٖ توبه Laptop   ٍPC ػبصگبس ثب اًَاع -

 ٌَکغ٘هختلف ل ّٕب غٗتَص

 mega , tiny , 90s ٕکشٍّب٘ؿًَذ ؿبهل ه ٖپشٍگشام ه SPI کِ ثِ صَست AVR ٕکشٍکٌتشلشّب٘ه ٖپشٍگشام توبه -

 PDI ثِ صَست XMEGA ػشٕ کٌتشلشّبٕ ه٘کشٍ کشدى پشٍگشام قبثل٘ت- 

 ً٘بص صَست دس کشدى پشٍگشام ٌّگبم دس ه٘کشٍ ً٘بص هَسد ٍلتبط تبه٘ي -

 FLASH , EEPROM ّبٕ حبفظِ سٗضٕ ثشًبهِ -

 اثؼبد کَچک -

 ٍلت 5 تب 1.8 اص :کشدى پشٍگشام ٍلتبط -

 فَ٘صث٘تْب توبهٖ سٗضٕ ثشًبهِ اهکبى -

 USB1.1   ٍUSB 2.0 ثب ػبصگبس -

 

 

Key Features 

• Short-circuit protection 

• Target interface protection 

• Programs both flash and EEPROM 

• Upgradeable for future device support 

• USB 2.0 compliant (full speed, 12Mbps) 

• Supports fuses and lock bit programming 
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• 4MHz ISP Rescue Clock (for mis-set fuses) 

• Supports target voltages from 1.8V to 5.5V 

• Powered from USB, does not require external power supply 

• Adjustable ISP programming speed (50Hz to 8MHz SCK frequency) 

 

 پرٍگراهر جساءا.3

1.3 LED ّای پرٍگراهر 

پشٍگشاهش ثَدى کبس ثِ آهبدُ ٍ ثَدى سٍؿي ًـبًگش :ػجض  

. 

 

 اتصالات پرٍگراهر 3.3

 پرٍگراهر راٌّوای دفترچِ

 

ثشإ پشٍگشام کشدى  PDIث٘تٖ ثَدُ، اتصبل  8ّبٕ   AVRثشإ پشٍگشام کشدى   ISPاتصبل اػتبدًذاسد 

 ، XMEGAه٘کشٍّبٕ 

 ذُ اػت.ؿکبهپَ٘تش تَػظ کبثل هشثَعِ تؼجِ٘  USBً٘ض ثشإ اتصبل پشٍگشاهش ثِ پَست  USB  اتصبلٗک  –

 

 POWER Select قرهس dipswitchکلید کشَیی 3.3

 تَاًذ دس دٍ ٍضؼ٘ت هختلف قشاس ثگ٘شد:اٗي کل٘ذ  هٖ

USB Power :ه٘کشٍکٌتشلش تغزِٗ ساػت ػوت ثِ ػَئ٘چ اٗي کـ٘ذى ثبxmega   ؿذُ تبه٘ي پشٍگشاهش اص 
 ثبؿذ.هٖ VCC=3.3vثشاثش  ٍلتبط اٗي .ً٘ؼت ه٘کشٍکٌتشلش ثشإ سٍؿي کشدى جذاگبًِ تغزِٗ هٌجغ ثِ ً٘بصٕ ٍ
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 . راُ اًدازی پرٍگراهر4

 ًصب 1.4

ثش سٍٕ ػ٘ؼتن  Atmel Studioٗب  AVR Studio ًشم افضاس ذٗثب ،َتش٘پشٍگشاهش تَػظ کبهپ ٖٗؿٌبػب ٕثشا

هشثَعِ ًصت  َٕسّبٍٗ اًجبم هشاحل ًصت، دسا َتش٘صَست ثب اتصبل پشٍگشاهش ثِ کبهپ يٗدس اًصت ؿذُ ثبؿذ. 

ؿشکت اتول، ثش  تًٗشم افضاس اص ػب يٗا ًٕؼخِ  يٗآخش گبىٗسا بفتٗؿَد. )ثِ هٌظَس دس ٖکبس هٍ آهبدُ  ؿذُ

 کل٘ک کٌ٘ذ(. ٌک٘ل يٗا ٕسٍ

 

 Windows 8ًصب تحت سیستن عاهل ٍیٌدٍز  3.4

ثجت ًـذُ دس  َٕسّبٗاػت کِ اهکبى ًصت دسا ٕثِ گًَِ ا ٖت٘اهٌ وبت٘تٌظ 8 ٌذٍصٗػبهل ٍ ؼتن٘دس ػ

هشثَط ثِ پشٍگشاهش  َٕسّبٗدسا AVR Studio ٕسٍ دس ٌّگبم ًصت ثشًبهِ يٗاص اهبٗکشٍػبفت ٍجَد ًذاسد. 

اًجبم  ت٘سا ثِ تشت شٗثشًبهِ هشاحل ص يٗاص ًصت ا ؾٍ٘ هـکل، پ تٗهحذٍد يٗسفغ ا ًٕصت ًخَاٌّذ ؿذ. ثشا

 . )دسحبلٖ کِ پشٍگشاهش ثِ کبهپَ٘تش هتصل ًجبؿذ(.ذ٘دّ

گَؿِ ػوت ساػت ٍ پبٗ٘ي صفحِ ًوبٗؾ قشاس دّ٘ذ تب ًَاس ػوَدٕ ػوت ساػت  ًـبًگش هبٍع سا دس (1

 کل٘ک کٌ٘ذ. Settingsصفحِ ثبص ؿَد. دس اٗي ًَاس ثش سٍٕ گضٌِٗ 

سا کل٘ک کشدُ، دس قؼوت ساػت پٌجشُ ثِ اًتْبٕ پبٗ٘ي پٌجشُ  Generalاص پٌجشُ ثبص ؿذُ گضٌِٗ  (2

 سا فـبس دّ٘ذ. Restart nowسفتِ ٍ دکوِ 

http://www.atmel.com/tools/atmelstudio.aspx
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 سا اًتخبة کٌ٘ذ. Troubleshootگضٌِٗ  (3

 سا. Advanced Optionٍ اکٌَى گضٌِٗ  (4

 اًتخبة گشدد.  Startup Settingsاص پٌجشُ ثؼذٕ ّن  (5

 ؿَد.اًذاصٕ هٖکبهپَ٘تش ؿوب هجذداً ساُ Restartدس هشحلِ ثؼذ ثب فـشدى دکوِ  (6

 ذ٘سا فـبس دّ 7ػذد  ذ٘اص اػذاد صفحِ کل ش،ٗص ٕصفحِ  ؾٍٗ ًوب ؼتن٘هجذد ػ ٕپغ اص ساُ اًذاص (7

 اًتخبة ؿَد.  Disable Driver Signature Enforcementٌِٕٗتب گض

سا ًصت کٌ٘ذ ٍ هغوئي ؿَٗذ کِ دس عَل ًصت اگش دس  Atmel Studioٗب  AVR Stuioاکٌَى  (8

 اًتخبة ؿذُ ثبؿذ. Install/Upgrade USB Driverهَسد ًصت دساَٗس ػَال ؿذ، گضٌِٗ 

اگش عٖ هشاحل ًصت اٗي ًشم افضاسّب، اص عشف ػ٘ؼتن ػبهل ٌٍٗذٍص ػَالٖ دس هَسد تبٗ٘ذ ًصت  (9

 سا اًتخبة کٌ٘ذ. Install this driver software anywayدساَٗسّب پشػ٘ذُ ؿذ گضٌِٗ 

 

 Windows 10ًصب تحت سیستن عاهل ٍیٌدٍز  3.4

 
Use the following steps to disable driver signature enforcement 

. 

    Click the Start menu and select Settings. 

    Click Update and Security. 

    Click on Recovery. 

    Click Restart now under Advanced Startup. 

    Click Troubleshoot. 

    Click Advanced options. 

    Click Startup Settings. 

    Click on Restart. 

 استفادُ از پرٍگراهر. 5

 Atmel Studioاستفادُ در هحیط  1.5

 ثِ هٌَٕ  AVR Studioظ٘اػتفبدُ اص پشٍگشاهش دس هح ٕثشا

Tools → AVR Programming 
ّن ثبٗذ ًبم ه٘کشٍکٌتشلشٕ  ثبؿذ کِ  Deviceاًتخبة کٌ٘ذ.  Toolسا ثشإ  AVRISP mkIIسفتِ ٍ گضٌِٗ 

 قشاس اػت پشٍگشام ؿَد.
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ًشم افضاس کٌتشل پشٍگشاهش سا ثِ دػت گشفتِ ٍ آهبدُ پشٍگشام کشدى ، Applyحبل ثب فـشدى دکوِ 

 ؿَد.هَسد ًظش هٖ کشٍکٌتشلش٘ه

 

 SPI شٍگشام کشدى دس حبلتػشػت پ ش٘٘تغ

 ثبؿذ( کشٍ٘چْبسم ػشػت کلک ه کٗکوتش اص  ذٗهقذاس ثب يٗ)ا

 هَسد ًظش ٕکشٍ٘هـخصبت ه
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 هَسد ًظش ٕکشٍ٘هـخصبت ه

 

فشکبًغ خبسجٖ ٍ ٗب  1.25حذاکثش سٍٕ   programming**تَجِ : دس ٌّگبم پشٍگشام کشدى فشکبًغ 

 .داخلٖ ه٘کشٍ تٌظ٘ن ؿَد

 Codevision AVR طیدر هح یریبکار گ 5.3

، ثشإ اػتفبدُ اص پشٍگشاهش دس هح٘ظ کذٍٗظى، ( ثِ آى اؿبسُ ؿذُ اػت 3.5کِ دس ثخؾ ثؼذ )  ٖل٘ثٌبثش دل

 ًؼخِ ظىٗصَست کِ اگش اص کذ ٍ يٗثذً٘ض ًصت ؿًَذ،  Atmel Studioٗب  AVR Studioثبٗذ ًشم افضاس 

v2.xx  ُصم اػت کِلا ذ،٘کٌٖهاػتفبدAVR Studio  ًِؼخ v4.xx   ِّن سٍٕ ػ٘ؼتن  4.18تشج٘حبً ًؼخ

ٍ  ًذاسد(. ٕبص٘ثِ آًْب ً ظىٗکذٍ ٍٖل ذ٘سا ّن ًصت کٌ 6 بٗ 5ٍُ ثش آى، ًؼخِ ػلا ذ٘تَاً ٖ)ه ًصت ؿذُ ثبؿذ

کبفٖ اػت ٍ ً٘بصٕ  v6.xxًؼخِ  Atmel Studioکٌ٘ذ، ًصت اػتفبدُ هٖ  v3.xx ًؼخِ ظىٗاگش اص کذٍ

 ً٘ؼت. 4ثِ ًؼخِ 

ٍ ًؼخِ هَسد ًظش سا  سا هـبّذُ، َٗهختلف اتول اػتَد ٕاص ًؼخِ ّب ٖکبهل ؼت٘ل ذ٘تَاً ٖه ٌک٘ل يٗااص 

 داًلَد کٌ٘ذ.

 ٖٗثب خغب ذ،٘ؽ کٌتلا کشٍ٘پشٍگشام کشدى ه ٕثشا ظىٗکذٍکِ دس ٖاًجبم ًـَد، ٌّگبه اگش ًصت هَاسد ثبلا

 ؿذ: ذ٘هَاجِ خَاّ شٗص ؿکلجِ٘ ؿ

http://www.atmel.com/tools/STUDIOARCHIVE.aspx
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 ثِ آدسع صٗش سفتِ: CodevisionAVR لشٗکبهپب ظ٘، دس هحپغ اص ًصت هَاسد ثبلا

Settings → Programmer 

تغ٘٘ش دّ٘ذ. اکٌَى   Atmel AVRISP mkII (USB)سا ثِ  AVR Chip Programmer Typeٍ هقذاس 

 تَاً٘ذ دس کذٍٗظى اص پشٍگشاهش اػتفبدُ کٌ٘ذ.هٖ

ًوبٗ٘ذ ٍ ثِ دلاٗلٖ اص قج٘ل کوجَد حبفظِ کبهپَ٘تش هبٗل ثِ ًصت کذٍٗظى اػتفبدُ هٖ v2.xxاگش اص ًؼخِ 

AVR Studio  ًِؼخv4.xx  ػلاٍُ ثشAtmel Studio  ٍِجَد داسد کِ تَػظ  ٖسٍؿً٘ؼت٘ذ،  6ٗب  5ًؼخ

 بٗ 5ثبؿذ )ًؼخِ  4 َٕٗثِ ًصت اػتَد ٕبص٘ثذٍى آًکِ ً ذٗثْشُ ثش 2 ظىٗاص پشٍگشاهش دس کذ ٍ ذ٘تَاً ٖآى ه

 :ذٗ٘ػول ًوب شٗص قٗسٍؽ، ثِ عش يٗاػتفبدُ اص ا ٕثشاٌَّص ّن ثبٗذ ًصت ثبؿذ(.  َٗاػتَد 6

 سفتِ، شٗثِ آدسع ص ظىٗکذ ٍ ظ٘دس هح

Project → Configure → After Build → Program Settings 
هَسد اٗي پبساهتشّب، دس ثخؾ ثؼذٕ ٗؼٌٖ  دس ـتش٘ثػبت )اعلا ذ٘دّ ش٘٘تغ شٗهشثَعِ سا ثِ ؿکل ص شٍٗ هقبد
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 ثبؿذ(:هَجَد هٖ 3.5

 سا تبٗپ کٌ٘ذ. atprogram.exeآدسع فبٗل  Program Directory and filenameدس خبًِ 

 ثِ ػٌَاى هثبل:

C:\Program Files\Atmel\Atmel Studio 6.1\atbackend\atprogram.exe 
 :ذ٘سا قشاس دّ شٗخظ ص ضً٘ Command Line Parameters ٖؼٌٗدٍم  ٔدس خبً

-t avrispmk2 -i isp -d MICRO program -fl -f “FILE_ADDRESS” 

 ٖلٗثِ آدسع فب ض٘سا ً  FILE_ADDRESS دادُ، ٍ هقذاس ش٘٘هَسد ًظش تغ ٕکشٍ٘سا ثِ ًبم ه MICRO ٍ هقذاس

کٌذ، دس ٖه ذ٘تَل ظىٗسا کِ کذٍ ّٕگض ٕلْبٗ)فب ذ٘دّ ش٘٘ؿَد تغ ختِٗس کشٍ٘ه ٔحبفظ ٕاػت ثش سٍ کِ قشاس

ثبؿذ  8هگب  ٕکشٍ٘ه کٗهب  ٕکشٍ٘هَسد ًظش قشاس داسد(. هثل اگش ه ٓپشٍط ٔدس داخل پَؿ EXEًبم  ثِ ٕاپَؿِ

 دسخَاّذ آهذ: شٗثِ صَست ص قشاس گشفتِ ثبؿذ، خظ ثبلا  D ٕشکتَسٗدس دا testثب ًبم  ضّ٘گض ً لٍٗ فب

-t avrispmk2 -i isp -d atmega8 program -fl -f “D:\test.hex” 

 ( هشاجؼِ ؿَد. 3.5)  ٕپبساهتشّب، ثِ ثخؾ ثؼذ يٗا شاهَى٘پ ـتش٘ػبت ثثِ هٌظَس کؼت اعلا

 ExecuteUser'sProgramِ ٌٗفؼبل، ٍ گضش٘غ Program the Chip ِ ٌٗکِ گض ذٗهغوئي ؿَ ي،ٍُٗ ثش اػلا

 فؼبل ثبؿذ.

ثبص  ٕپٌجشُ ا(، CTRL+F9 بًجش٘ه ٕذّب٘)ثب کل ذ٘کٌ ٖه لٗکبهپب ظىٗخَد سا دس کذ ٍ ٓاکٌَى ّش ثبس کِ پشٍط

 ًذاؿتِ ٍ ثغَس کبهل ٖٗدادُ ؿذُ، ٍ اگش ثشًبهِ خغب ؾٗدس آى ًوب لٗػبت هشثَط ثِ کبهپبکِ اعلا ؿَدٖه

هَسد ًظش  ٕکشٍ٘ؿَد کِ ثب فـشدى آى ه ًٖـبى دادُ ه ٕاهزکَس دکوِ ٓپٌجش يٗ٘پبؿَد، دس  لٗکبهپب

 ؿَد. ٖپشٍگشام ه

 ًٖدس عَلا بٍٗ  ِ٘اص ثبً ٕخظ فشهبى ثِ هذت کؼش ٓپٌجش کٗدکوِ،  يٗصم ثِ رکش اػت کِ ثب فـشدى الا

 يٗؿَد. ثٌبثشا ٖسا پشٍگشام کشدُ، ٍ ػپغ ثِ عَس خَدکبس ثؼتِ ه کشٍ٘ثبص ؿذُ، ه ِ٘فقظ چٌذ ثبًحبلت  يٗتش

ًِ،  بٗاًجبم گشفتِ  ح٘پشٍگشام کشدى ثِ عَس کبهل ٍ صح بت٘ػول بٗآ ٌکٍِٗ ا ٌگ٘پشٍگشاه هشاحل ذىٗد اهکبى

 ٍجَد ًذاسد.

 

 Command line utility (CLI)  ٌدٍزیپرٍگراهر در خط فرهاى ٍ یریبکار گ 3.5

پشٍگشاهش ٌٍٗذٍص ً٘ؼت٘ذ، ٍ هـکلٖ ّن دس اػتفبدُ اص  خظ فشهبى ظ٘ثِ اػتفبدُ اص پشٍگشاهش دس هح لٗاگش هب

 .ذ٘ثخؾ صشف ًظش کٌ يٗاص خَاًذى ا ذ٘تَاً ٖه ذ،ًٗذاس ظىًٗشم افضاس کذ ٍ ظ٘دس هح

 AVR Studio  ٍAtmel Studioکِ ًشم افضاسّبٕ  ٌٕذٗدس هَسد ػبختبس ٍ فشآ ٕهختصش ح٘دس اثتذا تَض

 ؿَد. ٖکٌٌذ دادُ ه ٖاػتفبدُ ه کشٍّب٘پشٍگشام کشدى ه ٕثشااص آى 

اػتفبدُ  کشٍّب٘پشٍگشام کشدى ه ٕثشا STK500.exe ثِ ًبم ٕاص اثضاس Atmel Studio ًشم افضاس 4دس ًؼخِ 

ًشم افضاس کِ  يٗا 6 ٔؿَد. اهب دس ًؼخًٖصت ه ،ٖاصل ٔاثضاس ثِ عَس خَدکبس ّوضهبى ثب ًصت ثشًبه يٗاؿذ. هٖ

 ثِ ًبم ٕگشٗ. دس ػَض، اثضاس دؼت٘اثضاس ً يٗاص ا ٕخجش گشٗؿَد دٖاسائِ ه Atmel Studioثب ًبم 
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atprogram.exe هختلف ٍ  ٕکشٍّب٘ه ٕثشا ٌگ٘پشٍگشاه بت٘ػول ٖؿذُ کِ توبه آى يٗگضٗجب

ثِ  ًٖذاؿتِ ٍ دػتشػ ٖک٘اثضاس ساثظ گشاف يٗ. اشد٘گٖه اثضاس اًجبم يّ٘و قٗهتفبٍت فقظ اص عش ٕپشٍگشاهشّب

ؿَد، ٖکِ تَػظ خَد کبسثشاى ًَؿتِ ه batchاٗجبد فبٗل ّبٕ اجشاٖٗ  بٍٗ  ٌذٍصٗخظ فشهبى ٍ قٗآى اص عش

  اػت. شٗپزاهکبى 

کشدى  پشٍگشام ٕثشا  STK500خَد اص اثضاس يٗ٘پب ٕدس ًؼخِ ّب  CodeVisionAVRل٘اص قج ًٖٗشم افضاسّب

ًصت  ؼتن٘ػ ٕسٍ AVR Studioاص  4 ثبؿٌذ کِ حتوب ًؼخِ ٖآى ه بصهٌذً٘ يٗثٌبثشاکٌٌذ. اػتفبدُ هٖ

سٍص ( خَد سا ثب ًشم افضاس ؿشکت اتول ث3ِثبلاتش اٗي ًشم افضاسّب )هثلاً کذٍٗظى ًؼخِ  ٕثبؿذ. اهب ًؼخِ ّب

 تَاًٌذ اػتفبدُ کٌٌذ. ّٖن ه atprogram.exeکشدُ، ٍ اص اثضاس 

اػت ثخَاٌّذ دس هح٘ظ خظ  ػَدهٌذ ٖکؼبً ٕفصل اسائِ ؿذُ اػت ثشا يٗا ٔکِ دس اداه ٖحبت٘تَض يٗثٌبثشا

کِ ثخَاٌّذ اص  ٖکؼبً بٗخَد سا پشٍگشام کٌٌذ؛ ٍ  ٕکشٍ٘ه ٖک٘گشاف ٕساثظ کبسثش چّ٘فشهبى ٌٍٗذٍص ٍ ثذٍى 

اص  4ثِ ًصت ًؼخٔ  ٖبج٘ثذٍى آًکِ احت ٌذ،ٗاػتفبدُ ًوب ٌگ٘پشٍگشاه ٕثشا v2.xx ًٔؼخ ظىٗکذٍافضاس  ًشم

 ثبؿذ. AVR Studioًشم افضاس 

 :ذ٘تَاً ٖؿوب ه  atprogram.exe ثب اػتفبدُ اص

 .ذ٘هَسد ًظش پشٍگشام کٌ ٕکشٍ٘ه ٕثش سٍسا  elf، ٗب hex  ،bin ٕلْبفبٗ •

 .ذ٘حبصل کٌ ٌبى٘اعو ٌگ٘پشٍگشاه بتػول٘ صحت اص •

 .ذ٘اًجبم دّ کشٍ٘هختلف ه ٕحبفظِ ّب ٕخَاًذى، ًَؿتي، ٍ پبک کشدى سا ثش سٍ بتػول٘ •

 .ذ٘دّ ش٘٘سا تغ ٕکبسثش ٍٕ اهضبّب ،ٕکبسثش ٔصفح ،ٖت٘اهٌ ٕتْب٘ث ،ٕػخت افضاس ٕقفل ّب تْب،٘ث َصف٘ •

 .ذ٘پشٍگشام کٌ کشٍ٘ه ٕسا ثش سٍ production ّٕب لفبٗ •

 .ذٗسا ثذػت آٍس َتش٘هتصل ثِ کبهپ ٕپشٍگشاهشّب ٖاص توبه ؼتل٘ •

 .ذ٘دّ ش٘٘سا تغ ٌگپشٍگشاه٘ پشٍتکل ػشػت ٍ ًَع •

، ٍ FLASH ،FLASHّبٕ کِ حبٍٕ هحتَٗبت حبفظِ اػت elf ٕلْبٗاص فب ًَٖع خبص production لٗفب

 ثبؿذ. ٍٖاحذ ه لٗفب کٗثِ صَست  تْب،٘ک ثلا(، ٍ ً٘ض فَ٘صث٘تْب ٍ XMEGA)فقظ دس  ٕکبسثش ٕاهضبّب

 :ذٗثشٍ شٗاثضاس، ثِ آدسع ص يٗثِ ا ٖدػتشػ ٕثشا

Start → All Programs → Atmel → Atmel Studio 6.x Command Prompt 

ٌٍٗذٍص  Command Promptٗب  خظ فشهبى قٗاص عش وب٘ثشًبهِ، هؼتق يٗثِ ا ٖدػتشػ ٕثشا گشٗسٍؽ د

ٍ ثب اػتفبدُ اص  ذٗدس آى ًصت ؿذُ ثشٍ Atmel Studio 6.x کِ ًشم افضاس ٕهٌظَس ثِ پَؿِ ا يٗثذاػت. 
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فبٗل  ثبص ؿذُ قشاس داسد، ثِ دًجبل ٓپٌجش ٖػوت ساػت ثبل ٔکِ دس گَؿ ٌذٍصٍٗ ٕجؼتجَ ٔجؼج

atprogram.exe قشاس داسد: شٗص ٔاص دٍ پَؿ ٖکٗهؼوَل دس  لٗفب ثگشدٗذ. اٗي 

C:\Program Files\Atmel\Atmel Studio 6.X\avrdbg 
C:\Program Files\Atmel\Atmel Studio 6.X\atbackend 

ٍ  7 ٌذٍصٗاػتبست ٍ ٕهٌَ ٕجؼتجَ ٔسٍؽ آى اػت کِ دس خبً يٗتش غٗ. ػشذ٘خظ فشهبى ثبص کٌ کٗػپغ 

 :ذ٘کٌ پٗسا تب cmd ػجبست تش،ثبلا

. ثِ ػٌَاى ذ٘دّ ش٘٘تغ ذٗقجل ثذػت آٍسدُ ا ٔکِ دس هشحل ٖثبص ؿذُ، آدسع خظ فشهبى سا ثِ آدسػ ٓدس پٌجش

 هثبل:

C:\>cd \Program Files\Atmel\Atmel Studio 6.1\atbackend 
 :ذٗ٘ثشًبهِ سا اجشا ًوب يٗا atprogram ػجبست پٍٗ ػپغ ثب تب

C:\Program Files\Atmel\Atmel Studio 6.1\atbackend> atprogram 

-ّبٖٗ سا کِ کبسثش هّٖوبى عَس کِ دس تصَٗش ثبل هـبّذُ هٖ ؿَد، ثب اجشإ ل٘ؼتٖ اص پبساهتشّب ٍ ً٘ض فشهبى

تَاًذ ثٌبثش ً٘بص خَد تؼ٘٘ي کٌذ، ثِ ّوشاُ ؿشح هختصشٕ دسثبسٓ ّش ٗک اص اٗي پبساهتشّب ًـبى دادُ هٖ ؿًَذ. 

سا ثِ ّوشاُ ًبم  helpص اٗي پبساهتشّب ٍ فشاه٘ي، کلؤ ثشإ ثذػت آٍسدى اعلؼبت کبهل دس هَسد ّش ٗک ا
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پبساهتش هَسد ًظش تبٗپ کٌ٘ذ. ثِ ػٌَاى هثبل ثب تبٗپ ػجبست صٗش تَض٘حبت کبهل دسثبسٓ آسگَهبى ّبٕ هشثَط 

 ثِ پشٍگشام کشدى ه٘کشٍ ًـبى دادُ هٖ ؿَد.

> atprogram help program 
ْب تَػظ کبسثش ضشٍسٕ اػت پشداختِ، ٍ پغ اص آى تَض٘حبت دس اداهِ ثِ ثشسػٖ پبساهتشّبٖٗ کِ تؼ٘٘ي آً

 هختصشٕ پ٘شاهَى پبساهتشّبٕ هشثَط ثِ فشاه٘ي خَاًذى ٍ ًَؿتي ٍ پشٍگشام کشدى اسائِ هٖ ؿَد.

 

 پاراهترّای ضرٍری

 ػجبستٌذ اص: ًبم پشٍگشاهش، پشٍتکل استجبعٖ ه٘بى پشٍگشاهش ٍ ه٘کشٍ، ٍ ًبم ه٘کشٍکٌتشلش.

 ثبؿذ. avrispmk2ثبٗذ ثشاثش ثب  MKII(: هقذاس اٗي پبساهتش ثشإ پشٍگشاهش t-ًبم پشٍگشاهش )

 (: ًبم ه٘کشٍٖٗ کِ قشاس اػت پشٍگشام ؿَد.d-ًبم ه٘کشٍکٌتشلش )

کِ ثِ پشٍگشاهش هتصل اػت  8ثِ ػٌَاى هثبل ثب تبٗپ ػجبست صٗش دس خظ فشهبى، اعلؼبت ٗک ه٘کشٍٕ هگب 

 گ٘شد.اًجبم هٖ infoؿَد. اٗي کبسثب اػتفبدُ اص فشهبى ًوبٗؾ دادُ هٖ

> atprogram -t avrispmk2 -i isp -d atmega8a info 
 

 فراهیي اجرائی

 ثشخٖ فشهبى ّبٖٗ کِ ث٘ـتش هَسد اػتفبدُ قشاس هٖ گ٘شًذ ػجبستٌذ اص:

chiperase, erase, info, program, verify 
اه٘ي گَٗبٕ ػولکشد آًْب ثَدُ، ٍ ػلَُ ثش اٗي دسخظ فشهبى اعلاػبت ثب تَجِ ثِ اٌٗکِ ًبم ّش ٗک اص اٗي فش

تَاى ثذػت آٍسد، لزا دس اداهِ فقظ ثِ ثشسػٖ فشهبى پشٍگشاهٌ٘گ پشداختِ کبهلٖ پ٘شاهَى ّشٗک اص آًْب هٖ

 هٖ ؿَد.

 

 programفرهاى 

-ؿذُ اػت، اػتفبدُ هٖاص اٗي فشهبى ثشإ پشٍگشام کشدى ه٘کشٍٕ هَسد ًظش تَػظ فبٗلٖ کِ قجلا کبهپبٗل 

ؿَد. آسگَهبى ّبٕ ضشٍسٕ اٗي فشهبى ػجبستٌذ اص ًبم حبفظِ إ کِ قشاس اػت پشٍگشام ؿَد، ٍ آدسع فبٗلٖ 

 کِ قشاس اػت ثش سٍٕ ه٘کشٍ سٗختِ ؿَد. دس اداهِ هتذاٍل تشٗي هقبدٗش اٗي آسگوبى ّب ًبم ثشدُ هٖ ؿًَذ. 

 

 ًام حافظۀ هَرد ًظر (1

fl- ؾ داخلٖ ه٘کشٍ ٗب ّوبى حبفظٔ اصلٖ ه٘کشٍ.ثشإ پشٍگشام کشدى فل 

ee-  ثشإ پشٍگشام کشدى حبفظٔ دائوٖ دادُ ٗب ّوبىEEPROM. 

fs- .ٍثشإ پشٍگشام کشدى فَ٘ص ث٘ت ّبٕ ه٘کش 

Lb- .ٍثشإ پشٍگشام کشدى لک ث٘ت ّب ٗب ّوبى قفل ّبٕ ػخت افضاسٕ ه٘کش 
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اٗي آسگَهبى آدسع هقذاس آى تؼ٘٘ي ؿَد.  هبًٖ اػت کِ لاصم اػتَدٍه٘ي آسگ (:f-آدرس فایل ) (3

 فبٗل ّگضٕ اػت کِ قشاس اػت ثش سٍٕ حبفظِ هَسد ًظش ًَؿتِ ؿَد.

 ثب اػتفبدُ ًوَد. هثلا ضً٘ گشٗد ٕضشٍس ش٘غ ٕهبى ّبَتَاى اص آسگ ٖ، هثبلا ٕضشٍس ٕهبى ّبٍَُ ثش آسگػلا

 ٖؿذُ تب اص دسػت ٖثشسػ بت٘صحت ػول ٌگ٘پشٍگشاه بت٘ػولپغ اص  - -verifyاضبفِ ًوَدى آسگَهبى 

اص پشٍگشام کشدى، کل  ؾ٘کِ پؿَد ثبػث هٖ -Cگَهبى افضٍدى آس بٗ حبصل ؿَد. ٍ ٌبى٘آى اعو

 پبک ؿَد. کشٍ٘ه بتٗهحتَ

قشاس  d ٕشکتَسٗکِ دس دا test لٗفب بتٗدس خظ فشهبى، هحتَ شٗثِ ػٌَاى هثبل ثب ٍاسد ًوَدى ػجبست ص

 بت٘ؿذُ ٍ ػپغ اص صحت ػول ختِٗهتصل ثِ پشٍگشاهش س 8هگب  ٕکشٍ٘فلؾ ه ٔحبفظداسد ثشسٍٕ 

 ؿَد. ٖحبصل ه ٌبى٘اعو

 >atprogram -t avrispmk2 -i isp -d atmega8a program -fl --verify -f 
d:\test.hex 

ثبؿذ، کل آدسع سا دس ث٘ي دٍ کبساکتش ( هSpaceٖ)  کبساکتش فبصلِ ّٕگض داسا لٗتزکش: اگش آدسع فب

 دّ٘ذ. ثِ ػٌَاى هثبل: قشاس "..."

>atprogram -t avrispmk2 -i isp -d atmega8a program -fl -f “d:\my 
folder\test.hex” 
 

. 

 ی. چٌد ًکتِ ٍ رفع هشکلت احتوال6

 ثوبًذ،  ٖچشاؽ قشهض آى ثِ عَس هذاٍم سٍؿي ثبق ذ٘کٌ ٖهتصل ه َتش٘کِ پشٍگشاهش سا ثِ کبهپ ٖاگش ٍقت

ؿٌبػذ. ػ٘ؼتن ػبهل پشٍگشاهش سا ًوٖ ًصت ًـذُ اًذ ٍ ٖآى ثِ دسػت َٕسّبٗآى اػت کِ دسا ًـبًگش

ثبؿذ. هؼوَل ثب ًصت  ًٖصت ًبقص آى ه بٍٗ  AVR Studioػلت ػوذُ اٗي هـکل ً٘ض ػذم ًصت 

هشثَط ثِ  صَست هـکل يٗا ش٘گشدد. دس غ ٖهـکل هزکَس ثشعشف ه ًشم افضاس، يٗا کبهل ٍ هجذد

 ثبؿذ.ػ٘ؼتن ػبهل کبهپَ٘تش هٖ

 ثبقٖ هبًذ، ث٘بًگش آى اػت  سٍؿي ًٖاگش دس ٌّگبم پشٍگشام کشدى، چشاؽ قشهض پشٍگشاهش ثِ هذت عَلا

دس اٗي حبلت پشٍگشاهش سا اص کبهپَ٘تش جذا ًوَدُ،  آهذُ اػت. ؾ٘دس پشٍگشام کشدى پ ٖٗخغبکِ 

 .ذٗ٘پشٍگشام سا هجذدا اص ًَ ؿشٍع ًوب بتٍ٘ ػول ذٗثجٌذثشًبهِ سا 

 ًشم افضاس ظٍ٘گشاهش دس هحاػتفبدُ اص پش ٕثشا Avrdude  ثبٗذlibusb ٌذ٘سا ًصت ک. 

 تزکش دادُ ؿذُ، فشکبًغ ّوبى عَس کِ دس ؿکل ثبلا ISP Clock چْبسم فشکبًغ  کٗکوتش اص  ذٗثب

 هَسد ًظش ثبؿذ. ٕکشٍ٘هکلاک 

 ًجبؿذ، آى قذس فشکبًغ کشٍ٘اگش پشٍگشاهش قبدس ثِ اتصبل ٍ پشٍگشام کشدى ه ISP Clock  سا کبّؾ

 .پشٍگشاهش ثتَاًذ ثِ پشٍگشاهش هتصل ؿَددّ٘ذ تب 

 دس هذ PDI ٕکشٍّب٘پشٍگشام ه ٕکِ ثشا Xmega ثبتَجِ ثِ ػغح ٍلتبط پبٗ٘ي اٗي  ؿَد، ٖاػتفبدُ ه

 .ذ٘اػتفبدُ کٌ TARGET POWERه٘کشٍّب، فقظ اص 
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 ٕکشٍّب٘اگش دس ٌّگبم پشٍگشام کشدى ه Xmega تَاًذ هقبدٗش ِ پشٍگشاهش فقظ هٖک ذٗهتَجِ ؿذ

ه٘کشٍ  ٖٗپشٍگشاهش کذ ؿٌبػب ٖثِ عَس کل بٗ ؼت،٘قبدس ثِ ًَؿتي آى ّب ً ّٖب سا ثخَاًذ ٍل ت٘ثفَ٘ص

ًذاسد، هـکل هشثَط ثِ هذاس  اهکبى پشٍگشام کشدى آى ٍجَدؿٌبػذ ٍلٖ سا تـخ٘ص دادُ ٍ آى سا هٖ

ثبلاػت، لاصم اػت هؼبئل ًؼجتبً  Xmega اص آًجب کِ فشکبًغ پشٍگشام کشدىؿَد. ٍ ثشد ه٘کشٍ هٖ

ثِ  Avccه٘کشٍ، ٍ ً٘ض پ٘ي  Vcc  ٍGnd ّٕب ي٘پ ٖگشدد: توبه تٗثشد سػبفٌٖ هشثَط ثِ عشاحٖ 

 100nfه٘کشٍ ٗک خبصى ثبٗبع  Vcc ّٕب ي٘اص پ کّٗش  ٕهتصل ؿًَذ؛ ثشاّبٕ هشثَط تشهٌ٘بل

ؿَد کِ حذاقل  اػتفبدُ ٕسگَلتَس بٗ ِٗقشاس دادُ ؿًَذ؛ اص هٌجغ تغز کشٍ٘هالاهکبى دس ًضدٗکٖ حتٖ

ّبٕ هَسد ً٘بص ثشإ ثبٗبع کشدى آى، دس هذاس هقذاس سٗپل سا دس خشٍجٖ داؿتِ ثبؿذ ٍ توبهٖ خبصى

هَسد ًظش خَد هشاجؼِ  ٕکشٍ٘ه ت٘تبؿٗثِ د ـتش٘ػبت ثاعلا ٕ. ثشاشُ٘قشاس دادُ ؿذُ ثبؿٌذ؛ ٍ غ

 .ذًٗ٘وب

 

 Firmware Update - پرٍگراهر ی. بِ رٍز رسا7ً

 ٕثش سٍ DFU-Programmerٍ ٗب  FLIP ًشم افضاس ذٗفشم ٍس پشٍگشاهش ثب ٖهٌظَس ثِ سٍص سػبًثِ 

تَػؼِ  ATMEL کِ تَػظ ؿشکت FLIP ًؼخِ اص ًشم افضاس يٗآخشب ًصت ؿذُ ثبؿذ. ؿو َتش٘کبهپ

 يٗپشٍگشاهش تَػظ ا ٖثِ سٍص سػبً ٖدس اداهِ ثِ چگًَگقشاس دادُ ؿذُ اػت.  CDدادُ ؿذُ، ثش سٍٕ 

 :نٗپشداص ًٖشم افضاس ه

 . ذًٗ٘وب بفتٗپشٍگشاهش دس تٗاص ٍة ػب ذ٘تَاً ٖسا ه ٖثِ سٍص سػبً ّٕب لٗفب يٗتش ذًٗکتِ: جذ

 

پ٘ي پ٘ي دس ٍضؼ٘تٖ قشاس دّ٘ذ کِ  3جبهپش سٍٕ پ٘ي ّذس  اػت هتصل کبهپَ٘تش ثِ پشٍگشاهش کِ حبلٖ دس

قشاس دّ٘ذ  ثشإ چٌذ لحظِ  سا شٍگشاهشپ سٗؼت ٍ جبهپشاػت اتصبل ثشقشاسکٌذ Uٍػظ ثِ پٌٖ٘ کِ حشف 

 .ظبّش ؿَد  AT90USB162اػن  Device Manager ٍدٍثبسُ ثش داسٗذ تب دس

 آهبدُ پشٍگشاهش کِ اػت آى دٌّذُ ًـبى ثبلاظبّش ًـذ  ICاگش اػن ٍ ؿذُ خبهَؽ پشٍگشاهش چشاؽ  کبس اٗي ثب

 ٍضؼ٘ت اٗي دس سا پشٍگشاهش ً٘ض ػبهل ػ٘ؼتن کِ صَستٖ دس الجتِ ثبؿذ، هٖ ٍس فشم جذٗذ ًؼخِ دسٗبفت

 .ثبؿذ ؿٌبختِ

سفتِ ٍ اگش پشٍگشاهش  Device Managerثِ قؼوت  ٌٍٗذٍص ػبهل ػ٘ؼتن دس هَضَع اٗي ثشسػٖ ثشإ

 ثِ هشثَط دساَٗس ؿذُ، دادُ ًـبى سًگ صسد اخغبس هتػلا ثب ٗؼٌٖ اػت ًـذُ ؿٌبختِ ؿوب کبهپَ٘تشتَػظ 

 .کٌ٘ذ ًصت صٗش هشاحل عجق سا آى سػبًٍٖضؼ٘ت ثِ سٍص 

 اًتخبة سا Update Driver Software گضٌِٗ ٍ کشدُ ساػت کل٘ک آى سٍٕ ثش Device Managerدس 

 . ًوبٗ٘ذ

 .کٌ٘ذ اًتخبة سا Browse my computer for driver software گضٌِٗ ؿذُ ثبص پٌجشُ اص -

 

 

 

http://www.atmel.com/tools/flip.aspx


 USB MKII Programmer User Manual V1.4                                          MKIIپروگرامر  یدفترچه راهنما
 

 صفحِ | 16

 

 

 

 

 :ًوبٗ٘ذ ٍاسد سا صٗش آدسع ؿذُ ثبص پٌجشُ دس -

C:\Program Files\Atmel\Flip 3.4.7\usb 
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 .دّ٘ذ تغ٘٘ش آى ثب هتٌبػت سا ثبل آدسع اػت هتفبٍت ؿوب ػ٘ؼتن سٍٕ ثش FLIP افضاس ًشم ًصت هکبى اگش

آهبدُ  پشٍگشاهش ٍ ؿذُ ًصت دساَٗس لحظِ چٌذ اص پغ ٍ ؿذُ ؿشٍع ًصت ػول٘بت Next دکوِ فـشدى ثب -

 .ثَد خَاّذ FLIP افضاس ًشم تَػظثِ سٍص سػبًٖ 

 :دّ٘ذ اًجبم صٗش تصبٍٗش عجق سا کبس هشاحل اکٌَى

 .ًوبٗ٘ذ اجشا سا FLIP افضاس ًشم

 اًتخبة سا AT90USB162 گضٌِٗ Device → Select هٌَٕ اص ٗب ٍ کٌ٘ذ کل٘ک chip آٗکَى سٍٕ ثش

 .کٌ٘ذ

 .دّ٘ذ فـبس سا OK دکوِ

 پشٍگشاهش ثِ ٍ کشدُ اًتخبة سا USB گضٌِٗ ؿذُ ظبّش هٌَٕ اص ٍ کٌ٘ذ کل٘ک USB cable آٗکَى سٍٕ ثش

 .ؿَٗذ هتصل
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 :کٌ٘ذ ثبسگزاسٕ سا جذٗذ ٍس فشم فبٗل

 File → LOAD HEX file هٌَٕ ٗب LOAD hex file آٗکَى

 .دّ٘ذ فـبس افضاس ًشم اصلٖ صفحِ اص سا RUN دکوِ ػپغ

سا ٗک  پشٍگشاهش ٗب دّ٘ذ فـبس سا Start Application دکوِ. اػت ؿذُ سػبًٖ سٍص ثِ ؿوب پشٍگشاهش اکٌَى

 .گ٘شد قشاس کشدى پشٍگشام ٍضؼ٘ت دس تب ًوبٗ٘ذ هتصل هجذدا ٍ ًوَدُ جذا کبهپَ٘تشثبس اص 

 


